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™
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Advanced Tutorial 
 
 
 

Abstract: Gain tips for modeling your own F1 car design from 
scratch and build on the skills learned in using the Fusion 360 F1 
in Schools Car Design Intermediate tutorial. Understand design 
options if you are using a 4-axis CNC approach. Get tips on 
modeling your own wheel designs and calculating the mass of a 
model. 
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Introduction 
Congratulations on choosing to work through the Autodesk Fusion 360™ F1 in 
Schools™ Car Design tutorials. Ideal for both first time F1 in Schools car designers 
and more seasoned car designers, these Fusion 360 tutorials are designed to get 
you up and running with the software quickly and effectively so you can have a car 
ready for manufacturing in record time. Start designing tomorrow’s fastest F1 in 
Schools car the fastest way now! 
 
With these tutorials, you will: 

 Get effective results faster – use the beginner tutorials to learn the software 

basics by simply modifying an existing car design to produce your own unique 

styling ready for manufacturing quickly and successfully. 

 Understand the F1 in Schools car body manufacturing process and improve 

your designs accordingly. Design your car body ensuring it is suitable for 

CNC manufacturing. 

 Save time by having access to a library of standard F1 in Schools car 

accessory part files, including the standard wheels, axle system and tether 

guides. 

 Get tips for how to ensure your car body fits the dimensions of the official F1 

Model Block. 

 Design your car so it has separate front and rear wing parts, fully integrated 

with the body design, prepared ready to export for manufacturing on a 3D 

printer. 

 Be reminded about F1 in Schools design regulations and how to check 

compliance as you are designing in 3D 

 Extend your skills through quick tips and exercises in our advanced tutorials 

related to wheel design and other features, such as design mass calculation, 

designing in 3D from a hand sketch, and CAM using Autodesk solutions. 

 Use our new Autodesk® Flow Design tutorial to analyze the aerodynamic 

performance of your design in 3D and make tweaks during your design 

development stages.  

 Be guided in the use of Autodesk® Showcase® to create stunning 

photorealistic renders of your final car assembly. 

Tutorial Work  
 

 
 
 
 
 
 

  

BEGINNER 

 

Learn the basics 
through creating the 
F1 Model Block and 
then be guided on 
how to create your 
own car design by 
modifying our 
standard F1 in 
Schools car using 
Fusion 360. 

INTERMEDIATE 

 

Discover how to 
use both parametric 
and free-form tools 
to create an F1 in 
Schools car body 
and wings from 
scratch. 

Use our standard 
wheel parts to 
complete the 
assembly. 

ADVANCED 

 

Realize even more 
potential through 
short exercises that 
provide you higher 
levels of design 
freedom on all car 
components, 
analysis and even 
use of our CAM 
solutions for CNC 
simulation and 

output. 
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Getting Started  

Downloading Fusion 360 

Fusion 360 is the first 3D CAD, CAM, and CAE tool of its kind. It connects the entire 
product development process in a single cloud-based platform that works on both 
Mac and PC, as well as has many features accessible from web browser. To review 
the Fusion 360 user interface, refer to the F1 in Schools Car Design Beginner tutorial 
or click on the following link: 
www.autodesk.com/products/fusion-360/features. 
 
To download and use Fusion 360 you will need an Autodesk ID.  As a student or 
educator, you can obtain an Autodesk ID and Fusion 360 at 
www.autodesk.com/education/free-software/fusion-360. 
 

 
 

The design files that you create in Fusion 360 are saved to the cloud-based 

Autodesk 360 (A360) platform in a Project folder. This means you can access 

your design files from any web browser or computer with Fusion installed by 

simply logging in with your Autodesk ID. Projects can be shared with other Fusion 

360 user allowing for design collaboration. As you create your designs, Fusion 

360 will save versions and keep a record of your progress. 

 
Note: Fusion 360 is currently available for those who are 13 years of age or older.  

Datasets 

In this tutorial, you learn tips for modeling your own F1 car design from scratch so no 
datasets are provided.  Follow the process below to import any existing datasets you 
have created or datasets provided with the beginner and intermediate F1 in Schools 
Car Design tutorials.   
 
Fusion 360 is cloud-based software. This means you have access to your project 
files anywhere, as long as your files are saved to a project or a folder in a project. We 
need a few files to complete our car so let’s upload them to our F1 in Schools project 
folder. 
 
Uploading a dataset: 
 

1. Download the dataset to your computer. 

http://www.autodesk.com/products/fusion-360/features
http://www.autodesk.com/education/free-software/fusion-360
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2. In Fusion 360, click the upload button. 

 
3. Click select files. 

 

 
 
4. Locate your files and select them 

 

 
 

5. Click upload 

 
 

Now these files are yours to access wherever you have an internet connection  
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Video Tutorials 

Download the video tutorials supporting this guide. The video tutorials offer the same 
step-by-step software instruction for learners that prefer guidance through video 
format. 
 

F1 in Schools Rules and Technical Regulations 

 
It is extremely important to that you design your car to comply with the current F1 in 
Schools rules and regulations. Each country has slightly different specifications that 
may change from year to year. It is critical that you download and review your 
country’s F1 in Schools Rules and Regulations documentation and design your car to 
the outlined specifications. Activities in this tutorial leverage F1 in Schools rules and 
regulations for 2015-2016 and may not apply to your country.  
 
IMPORTANT: Please confirm the F1 in Schools rules and regulations for your 
country and competition before getting started. Go to your local F1 website and 
download the F1 in Schools rules and regulations documentation 
http://www.f1inschools.com/international-sites/.  
 

Introduction to Fusion 360 
To review the Fusion 360 user interface, refer to the F1 in Schools Car Design 
Beginner tutorial or click on the following link for more information on the software 
features: www.autodesk.com/products/fusion-360/features. 
 

 

Tip Set 1: Alternative Approaches to Modeling a Car 
After completing this tip set, you will have learned various methods of modeling a car 
in Fusion 360 
 

 Create a T-Spline Block  

 Use the Sculpt environment in more creative ways 

 Create a loft profile 

 Create alternative wing structures 
 

For video instructional support, download the step-by-step video tutorials for this tip 
set. 
  

http://www.f1inschools.com/international-sites/
http://www.autodesk.com/products/fusion-360/features
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Step 1: Create a T-Spline Block 

 
1. In the Sculpt environment, draw a 210mm X 50mm rectangle. 

 

 
 
 Tip: Drawing the block 210mm rather than 223mm means you draw it the maximum 
possible size it can be machined. 
 

2. Create -> Extrude. This is like Press Pull. 
 

 
 

3. Extrude it by 32.5mm in both directions as usual. Maintain creased edges or it 
goes rounded. 
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4. This will create a hollow shape. Use Modify -> Fill Hole. 

 

 
 

5. Click the edge, make sure ‘Maintain Crease Edges’ is checked or it gives it 
rounded edges. 

 

 
 

6. Do the other side also. 
 

7. In the Model Environment, add the Tether Line Slot and CO2 canister 
chamber in the normal way. 
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8. By double-clicking the Form icon on the timeline you can now edit the block 
as a sculpted object. 

 

 
 

9. You can now use the entire block to push, pull and twist to shape a car body. 
 

 
 

10. Add a line of symmetry through the center to duplicate all your edits to both 
sides of the car. 

 

    
 
 

11. Subdividing the faces will give you more control. 
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12. Modifying as a wireframe will make it easier to see where the canister 
chamber and tether line guide are located. 

 

 
 

Step 2: Using the Sculpt environment in more creative ways 

 
The Freeform Sculpt environment allows you a large amount of flexibility and 
experimentation opportunities. You need to be careful that what you create is within 
the F1 in Schools Technical Regulations and also, physically possible to construct. 
 

1. When editing, the T-Splines in your model cannot cross over, so look at how 
close they are together. 

    
 
 
 
 
 

 
2. Even if you think it has worked, when you Finish Form, an error message will 

show, highlighting the areas of bad geometry. 
 

 
 

Translating this edge down, it is 
close to the next T-Spline 

T-Splines have now crossed 



11 | P a g e  

 

3. One way to prevent this is to translate the T-Splines below it, further down. 
 

    
 
 
 

 
 
 

 
 
 

 
 

4. Now the T-Spline will not cross. 
 

 
 

  

Select the Edge below 

Now it has been pulled down 
there is more room 
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5. Using a mixture of the options on the Triad Indicator you can experiment with 

a variety of organic forms. 
 

 
6. Combine these with Parametric modelling, sketching from underneath… 

 

 
 

7.  And Press Pull… 
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8. And cutting from the end plane… 
 

 
 

9. To create unusual shapes. 
 

 
 

10. Remember, you can go back into T-Spline editing at any time. 
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Tip: Remember to check the rules and regulations using the Sketching technique 
described in the Intermediate Tutorials. 

 
11. Be aware that using this method, you can produce shapes that will not fit 

inside the main block. 
 

 
 

12. Always check your model afterwards by using a sketch to check the 
dimensions. 
 

 

Step 3: Create a Loft Profile 

 
1. One way to create an Organic-looking shape in the Model Environment is by 

creating a Loft between two or more sketch faces. They can be different 
shapes. 
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2. Create -> Loft. 

 
 

3. The two parts will join together. 
 

 
 

4. Different shapes and positions create different lofts. 
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5. If you create a series of shapes, it can act as a rail and loft between them, so 
you can create more unusual loft shapes. 

 

   
 

6. Cutting sections out of the shapes can be useful too. 
 

    
 

Step 4: Create Alternative Wing Structures 

 
1. The wings can be made using Parametric or Freeform methods.  

 
2. By creating an Offset plane you are able to draw on the nose area of your 

car. 
 

 
 

3. You can then draw the profile of your wing (Referring to rules T10.1 – 
T10.12). 
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4. Before using Sketch -> Offset feature to create the underneath edge. 
 

   
 

  
 

5. Be sure to mirror to the other side. 
 

 
 

6. Press Pull and add any Fillets. 
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7. You can adjust the angle of the wing by selecting it in the Browser Menu, 
selecting Move and using the rotate command. 

 

 
8. You can quickly edit and 3D print a range of angles to test for efficiency and 

effectiveness. 

 
 

9. Also on the Body in the Browser Window, Copy and Paste of these bodies 
allows for some interesting front wing concepts. 

 

 
 

10. Using the Sculpt Environment, you are able to create Freeform shapes. If you 
select faces on both sides… 
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11. You can then delete them to create holes through your wing. 

 

 
 

12. You could also cut holes at angles by constructing a Plane at an angle. 
 

  
 

13. Draw your cut-through shape. 
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14. Extrude it to create an angled cut-through. 
 

 
 

15. Also, your front wing does not have to be supported in this way. You can 
mirror bodies to create a range of support structures. 

 
16. Using the Sweep Command (Create -> Sweep) you can produce interesting 

support structures above the nose cone. Sketch a Profile shape on one plane 
and a Path on another. 

 

 
 

17. Create -> Sweep. 
 

 
 

18. Mirror the Body Create -> Mirror 
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19. It is ready to support a range of front wing designs. 
 

 
 

20. The rear wing follows many of the same principles. You can create interesting 
shapes by using a cross section shape from a sketch in the Sculpt 
environment. 

 

 
 

21. Using geometric shapes and the Trim tool, you can create a range of cross 
section shapes. 

 

 
 

22. Extrude to the desired length. 
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23. Fill in the holes and Edit Form to create a range of shapes. Be sure to add the 
line of symmetry. 

 

 
 

Tip Set 2: Using an Immersive Sketch 
In this second set of tips, you will learn how to use an immersive sketch technique as 
an alternative approach to designing the F1 in Schools Car body. Most good designs 
start off with a simple pencil sketch, and this is still an effective and quick way to 
generate ideas. For video instructional support, download the step-by-step video 
tutorials for this activity 
 

Step 1: Sketch a Design  

1. Begin by sketching an F1 in Schools block from the side on a piece of A4 
paper. Use this as a basis for sketching your car ideas. You could even 
photocopy a drawing of the block and use it time and time again to produce a 
range of designs. 

 

 
 

2. Use this as a basis to draw the Plan view, using the same dimensions. You 
can do this on the same piece of paper. Scan this into your computer or take 
a clear photograph. 
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3. Open a block model in Fusion 360 

 

 
4. Select Insert -> Attached Canvas. 

 

 
 

5. From the ‘Attached Canvas’ window, select the side of the car as shown. 
Make sure ‘Display Through’ is checked (so you can see it through your 
block), and insert your image.  
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6. You may need to enlarge or reduce your sketch. Use the corner handle on 

the Triad to scale your sketch.  
 

 
 

7. Scale your sketch so that the CO2 chambers match up and the size is 
correct. Make the block wireframe to make it easier to see your sketch. Flip 
the image if it is the wrong way around. 

 

 
 

8. Do the same on the top of the car also, using the other sketch. 
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Step 2: Use as a Template 

  
1. You can now use this as a template to sketch over and cut your car.  

 

 
 

2. Start by sketching over the shape from the side. 
 

 
 

3.  Use ‘Push Pull’ to cut away the unwanted part. 
 

 
 

4. You can now do the same from the top of the car. 
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5. You also need to do the same for the rear of the car. You could use a sketch 
for this part as well if you wish. 

 

 
 

6.  Hide your Canvas’ in the Browser Window. 
 
 

 
 

 
 

7.  You should now have the basis of a car. 
 

 
 

  

Click the light bulb 
icon. 
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Design for Manufacture Considerations 
 
It is very important to have a basic understanding of how the car body will be 
manufactured in order to create a successful design. In industry, all products are 
designed with consideration given to any limitations that may exist due to the 
available or chosen manufacturing methods. An F1 in Schools car is no different. It is 
important to understand the manufacturing technology and process requirements so 
that the car designer can create a car body shape that is actually possible to 
manufacture by a CNC machining process. 
 
CNC (Computer Numeric Control) machining is a very important and widely used 
manufacturing method in industry. This is why it is compulsory for F1 in Schools 
teams to manufacture their car bodies using a CNC machine. Many schools are 
equipped with 3 axis CNC machines which is the minimum requirement for car body 
manufacture. High speed 3 Axis CNC Routers are ideal for making F1 in Schools car 
bodies. Autodesk F1 in Schools tutorials support manufacturing via a Denford 3 Axis 
CNC Router. 
 
The recommended standard CNC machining method is to machine car bodies using 
two machining operations, one operation from the left side of the car and one from 
the right side. For each operation the F1 Model Block is mounted on its side in the 
CNC machine via clamping in the special F1 in Schools Machining Fixture. This 
method provides for a wide range of car profile designs to be machined with a 
minimum amount of machining operations. The picture below illustrates this. 

 

 
 
The green arrows above indicate the 3 axis direction system of the CNC machine. 
These are the 3 axes of direction that cutting tools move in, often simultaneously, in 
order to remove the excess Model Block material revealing the profile of your F1 in 
Schools racer.  
 
The standard method of manufacture is to machine the car body using two 
machining operations, one machining operation on each side of the car. The right 
side of the car is machined with the Model Block mounted as pictured above, the 
Model Block is then rotated 180 degrees about the x axis to machine the left side of 

+Z 

+Y 

+X 

¼ inch / 6.35mm 
diameter ball 
nose cutting tool 

Fixture 

F1 Model 
Block 
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the car body. The left side machining operation is simply a mirror image of the right 
side. 
 
Due to there being only 3 axes or directions of movement that the cutting tool can 
move in, some shapes or profiles may not be possible to machine. The diagrams 
below help explain this further. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As pictured on the right, it is possible to mount the Model 
Block in the CNC Router oriented to allow for machining 
from the car body top. This can then also be inverted to 
allow for machining of the car body bottom if required. 
These would be additional machining processes increasing 
complexity, time and cost to machine the design.  Note that 
with this design, there are still areas shown in red that the 
cutter cannot access, these areas are not possible to 
machine using any orientation. 
 
Finally, the size and shape of the cutting tool 
needs to be considered. The standard machining 
process for F1 in Schools car bodies uses a ¼ 
inch (6.35mm) diameter ball nose shaped cutter. 
Looking at the diagram above you will notice that a 
small radius / fillet of material (in red) remains 
where two edges meet at an internal sharp corner. 
This is due to the ball nose shape of the cutter tip. 
  

ABOVE: Material remains in the 
sharp internal corners (shown in 
red) due to the ball nose shape 
of the cutter tip (shown in grey). 
Model Block material that will be 
machined away is indicated in 

green 

The Model Block (green) and 
car profile (blue) are shown 
oriented on their side in the 

CNC machine. The dark blue 
circle is the CO2 canister hole 

in the Model Block. 
The cutting tool (shown in 
grey) can remove all of the 

material to produce the design 
(shown in blue) as it can be 
reached from left and right 

sides of the car. 
The material shaded in red 

cannot be removed as the tool 
cannot reach this area from the 

left and right sides. 
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The example to the right is a similar body profile to the 
above example, however here the slot down next to the 
left and right sides of the CO2 canister housing is not as 
wide. The slot is narrower than ¼ inch / 6.35mm and 
therefore the cutter cannot access and remove the 
material in red. Any slot or groove features like this that 
are narrower than the diameter of the cutter cannot be 
machined. 
 
Hopefully now you have a better understanding of the CNC machining process used 
to manufacture F1 in Schools car bodies and the few limitations that this imposes. 
You should now keep these factors in mind as you unleash your creativity in 
designing your F1 in Schools racer car bodies. 
 

Tip Set 3: Machining from 4 Axes 
In this third set of tips, you will be shown what is possible if you machine your car 
from four axes instead of the usual two or three. For video instructional support, 
download the step-by-step video tutorials for this activity. 
 

1. With standard 2 axis machining, the car is cut from the F1 in Schools Foam 
Block on two sides. 
 

 
 

  

What a car looks like having 
been cut from 1 side first. 
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2. The block is rotated after it has been cut on one side, to then cut the other. 

 
 
 
 
 
 
 

          
 

3. As the cutting tool cannot bend, areas on the top and bottom of the car are 
impossible to cut using this method. One way to think of what is possible is if 
you cannot see the part you wish to cut from the side, it isn’t possible! 

 

 
 

4. It is however, possible to cut the car from above and underneath, by rotating 
the block at 90° intervals. 

 
 
 
 
 
 

 
 

      
  

Cutting tool cuts in this direction. The block 
is rotated manually to cut the other side. 

Cutting tool cuts in this direction. The block 
can be rotated to cut these sides also. 



31 | P a g e  

 

5. This opens up more possibilities with the design of your car. 
 

6. It allows cuts directly into the face of the body…. 
 

 
 

7. …That you wouldn’t see or be able to cut, from the side. 
 

 
 

8. Or allows those side pods to be a different shape. 
 

 
 

9. As you wouldn’t be able to get them cut from the 2 axis method. 
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10. The bottom of the car can also be used creatively. Draw a sketch and mirror 

underneath the side pods. 
 

 
 

11. Extrude these using Push Pull. You can channel the air under the side pods 
in a range of ways. 

 

 
 

12. Also, the Tether Line slot can be altered. 
 

 
 

Tip Set 4: Modeling Your Own Wheel Designs 
In this set of tips, you will be shown some tips regarding designing your own wheels. 
For video instructional support, download the step-by-step video tutorials for this 
activity. 
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Step 1: Model a Basic Wheel  

 
1. One of the first things to consider before designing your own wheels is what 

method you will use to help them spin: bearings? What size bearings? How 
will they fit in the wheel? 

 
2. Secondly you will need to consider what material and manufacturing method 

you will use. This will determine features like the wall thickness. Refer to rules 
T8.1-8.10 regarding wheels.  

 
3. Most wheel designs may begin as a cylinder. 

 

 
 

4. Concentric circles can be drawn on one face. 
 

 
 

5. These are then extruded. 
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Step 2: Spokes 

 
1. Spoke – effects can be created by choosing the outside face and sketching a 

circle that represents the wall thickness of the wheel. 
 

 
 

2. On the same face, a line is drawn from the center of the circle to the outside. 
 

 
 

3. Select Sketch -> Circular Pattern. Choose the line to be the Object and the 
Center Point, the center of the circle. 
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4. You can change the Quantity of the lines. Keep it as an even number. 
 

 
 

5. Now draw a circle in the center, the same size as the axle / bearing holder on 
the other side. 

 

 
 

6. Now extrude alternate gaps in between the lines. 
 

     
  



36 | P a g e  

 

7. Add fillets as required. 
 

 

Step 3: Wheel Housings 

 
1. Wheel Housings allow an alternative method of securing the wheels to the 

body. 
 

2. These can be produced and connected in a variety of ways. You can offset a 
sketch. 

 

 
3. Extrude it and add holes for the wheels. 

 

 
 

4. This can then be slotted into the car. 
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Tip Set 5: Analyzing the Mass of a Model  
In this set of tips, you will be shown how to calculate the weight of your car model. 
Rule T3.5 states the total weight of the car excluding the CO2 gas cylinder should be 
a minimum of 55 grams. For video instructional support, download the step-by-step 
video tutorials for this activity. 
 

Step 1: Apply the Material to the Block 
 

1. Using the F1 in Schools block first, you should set the material density so that 
your block is the standard weight of 112g. Open your F1 in Schools block. 
 

 
2. Right click the block and select Physical Properties. 

 

 
 

3. In the Materials Library, open the Plastics folder and scroll to find 
Polyurethane Foam. Select and drag it onto the block. 
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4. This material will now appear at the top of the Physical Material window. 
Right click it and select Edit. 

 

 
5. In the Materials Editor, select Advanced, then select the Physical tab. 

 

    
 

6. In the Mechanical Density window, input the density to be 163g/cm3 and 
press enter on the keyboard. Press Apply and Cancel to shut the window. 
Close the Physical Material window. 
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7. In the Browser window, select the bodies folder and right click the car body. 

Select Properties. 
 

 
 

8. The mass of the block should indicate 112.001g. This same process can be 
used to measure the mass of your designed car body. Enter 159.55 Kg/m3 as 
the density of the foam material when applying to your car. 

 
Step 2: Calculating the Mass of the Other Parts of the Car 
 

1. Any other parts of your car (for example 3D printed wings) will need to be 
done in a similar method. For example, ABS filament commonly used in 3D 
printers weighs 1060kg/m3 

 
 

 
 

2. However, your wing is unlikely to be completely solid when printed and so it 
may be significantly lighter than calculated. Sometimes measurements need 
to be carried out on the physical items also. 
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3. Remember to include the weight of the axles, tether line guides, and wheels. 
 

Next Steps 
Now that you have read through the advanced tutorial, it is time to practice and 
experiment further with Fusion 360 to see what it is capable of. Familiarize yourself 
further with the Technical Regulations (http://www.f1inschools.co.uk/rules-and-
regulations-/) and design your own world-conquering F1 in Schools Car. Fusion 360 
is updated regularly and will feature a range of cool features you could potentially 
add. 
 

  

http://www.f1inschools.co.uk/rules-and-regulations-/
http://www.f1inschools.co.uk/rules-and-regulations-/
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